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REMINDER: Reimbursement for RCA Payments 
Based on Submission of a RCA Report 
Beginning with the Quarter 2, 2014 reporting period (April 1 – June 30, 2014), 

the reimbursement of RCA payments is based on the submission of  the RCA 

Report. Reimbursement is no longer based on expenditures reported on SEAGR 

under BRASS code 182.   

 Each county that makes RCA payments is required to generate the RCA 

Report and submit it to DHS on a quarterly basis, due 20 days after the 

end of the quarter.  

 All RCA Payments must use BRASS code 182 and have a Finalized RCA 

Payment Worksheet entered in SSIS with a Worksheet Effective Date on 

or before the Payment Service Dates in order to create a RCA claim.  

 The reimbursement is based on the Eligible amount from the RCA Report.  

Non-eligible amounts are not included in the reimbursement. 

 Expenditures must still be reported on the SEAGR report under BRASS 

code 182. 

Hint: The RCA report will be included as part of the Northstar Care Fiscal  

Reconciliation process coming in 2015.  

Title IV-E Abstract Report  
and Special Cost Code 10  
Title IV-E Eligible payments paid using Special Cost Code 10 will not create a 

claim on your Quarter 4 (Oct 1 through Dec. 31), 2014 Title IV-E Abstract Re-

port. The new edits for Special Cost Code 10 required to create claims will be 

included in Version 15.1. These claims will be included in your Quarter 1 (Jan 1 

through March 30) 2015 Title IV-E Abstract Report. 

If you have any questions, please contact the 

 SSIS Help Desk at 651.431.4801 dhs.ssishelp@state.mn.us 

REMINDER: February 11th Fiscal Mentor Meeting 
Register now on TrainLink.  

The Fiscal Meeting agenda will soon be posted to CountyLink. 

http://www.dhs.state.mn.us/main/idcplg?IdcService=GET_DYNAMIC_CONVERSION&RevisionSelectionMethod=LatestReleased&Redirected=true&dDocName=id_000404
https://www.dhssir.cty.dhs.state.mn.us
http://www.dhs.state.mn.us/main/idcplg?IdcService=GET_DYNAMIC_CONVERSION&RevisionSelectionMethod=LatestReleased&dDocName=Training#P15_639
mailto:dhs.ssishelp@state.mn.us?subject=Inquiry%20from%20SSIS%20Update%20Newsletter
mailto:dhs.ssishelp@state.mn.us?subject=Title%20IV-E%20Abstract%20Report%20Question%20(SSIS%20Update%20411)
http://pathlore.dhs.mn.gov/stc/ssis/psciis.dll?linkid=3014&mainmenu=SSIS&top_frame=1
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How do I replace the Emergency Foster Care Rate in SSIS with 
an initial MAPCY (Minnesota Assessment of Parenting for Chil-
dren and Youth) assessment? 

 

The Emergency Foster Care Rate applies ONLY during the first 30 days of a continuous 
placement for foster care. After that it expires. 

 
Ordinarily, the assessor sets the effective date of a MAPCY assessment in the set-up 
screen. However, SSIS will typically override that date upon approval if this is the first  
approved assessment for a particular home, which would be the case when the  
Emergency Foster Care Rate has been in effect. 

 

Details are in the table below: 

 

 

It is expected that this implementation of MAPCY will fulfill the legislation in MN Statutes, 
section 256N.26, subdivision 6. 

 

 

 

 

 

 

 

 

 

 

 

 

 

See page 3 for more MAPCY information. 

N O R T H S TA R 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

Have more  
questions about 
Northstar? 
 
Northstar Policy  
or Program Questions 

Send additional program/
policy questions related to 
Northstar Implementation to: 
northstar.care@state.mn.us 
Or call M-F, 9am-3pm 
(651) 431-4485. 
 

SSIS Entry Questions 

For help with SSIS entry, 
have your Mentor Coordina-
tor contact the SSIS Help Desk  
at 651-431-4801 or email at 
dhs.ssishelp@state.mn.us 

Approved MAPCY Level SSIS v 14.4 Effective Date SSIS v 15.1 Effective Date 

Level D or higher 
Beginning of placement  

location 
Beginning of placement  

location 

Level B or C, 
with approval date days 

1-30 of continuous 
placement 

Day 31 of continuous  
placement 

MAPCY Approval Date 

Level B or C,  
with approval date  
day 31 or later of  

continuous placement 

Day 31 of continuous  
placement 

Day 31 of continuous  
placement 

http://www.dhs.state.mn.us/main/idcplg?IdcService=GET_DYNAMIC_CONVERSION&RevisionSelectionMethod=LatestReleased&dDocName=id_000404
http://www.dhs.state.mn.us/main/idcplg?IdcService=GET_DYNAMIC_CONVERSION&RevisionSelectionMethod=LatestReleased&dDocName=id_000447
http://www.dhs.state.mn.us/main/idcplg?IdcService=GET_DYNAMIC_CONVERSION&RevisionSelectionMethod=LatestReleased&dDocName=id_000441
http://www.dhs.state.mn.us/main/idcplg?IdcService=GET_DYNAMIC_CONVERSION&RevisionSelectionMethod=LatestReleased&dDocName=dhs16_144334
https://www.revisor.mn.gov/statutes/?id=256N.26
https://www.revisor.mn.gov/statutes/?id=256N.26
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N O R T H S TA R 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

Have more  
questions about 
Northstar? 
 
Northstar Policy  
or Program Questions 

Send additional program/
policy questions related to 
Northstar Implementation to: 
northstar.care@state.mn.us 
Or call M-F, 9am-3pm 
(651) 431-4485. 
 

SSIS Entry Questions 
For help with SSIS entry, 
have your Mentor Coordina-
tor contact the SSIS Help Desk  
at 651-431-4801 or email at 
dhs.ssishelp@state.mn.us 

Can MAPCY assessments, completed during the pilot phase,  

be copied and used to determine eligibility for Northstar  

Adoption Assistance or Northstar Kinship Assistance? 

MAPCY Changes Require Updating, Rescoring MAPCY Tools 

MAPCY pilot agencies wonder whether MAPCY assessments completed during the pilot phase 
may be copied and used as part of the eligibility determinations for Northstar Adoption Assis-
tance or Northstar Kinship Assistance.  As a result of the field test that 24 agencies participat-
ed in, significant changes were made to both the indicators and scoring of the MAPCY.  These 
indicator and scoring changes are in SSIS release v14.4.  Because of these major scoring 
changes, MAPCY assessments from prior to release v14.4 cannot be used in eligibility deter-
minations for either Northstar Adoption Assistance or Northstar Kinship Assistance. 

Prior MAPCY assessments need to be updated in order to be rescored. This could involve a 
completely new assessment. However, If there are no changes in circumstances, it can be 
done using the copy MAPCY function, entering a more recent effective date, reviewing to 
verify that all indicators are answered appropriately and then rescoring the MAPCY.  Once 
approved, these updated MAPCYs can be used for eligibility determinations. 

When will Northstar Care for Children need foster homes to be 

licensed to earn the new Northstar Care state share? 

Unlicensed Foster Homes and Northstar Care Fiscal Reconciliation 

Expenditures for foster care (BRASS Codes 180, 181, and 188) are included in the Northstar 
Care Fiscal Reconciliation Process. BRASS Code 188 - Supervised Independent Living (18 up to 
21) settings do not require licensure. However, BRASS Codes 180 - Treatment Foster Care and 
181 - Child Family Foster Care require a state or tribal child foster care license. 

For BRASS Codes 180 and 181, federal Title IV-E will not pay a federal share until the home is 
licensed. 

Northstar Care state share follows a different policy. After extensive discussions with the 
Northstar Care Fiscal Workgroup, the Northstar Care state share is available for up to the first 
six months of a placement in an unlicensed home that is in the process of getting licensed. 
After six months of placement, unlicensed homes will be excluded from the Northstar Care 
Fiscal Reconciliation Process, and therefore will no longer earn the new Northstar Care state 
share. 

This is true for both legacy foster care and Northstar Foster Care, regardless of whether the 
child is Title IV-E eligible or non-Title IV-E eligible. 

Implementation of this policy will begin with the July-September 2015 quarter. Until then, no 
unlicensed home will be excluded from the Northstar Care Fiscal Reconciliation Process. This 
timing will ensure that counties and tribes have six months to get all unlicensed homes li-
censed, whether legacy or Northstar Care. Beginning with the July-September quarter, place-
ments in BRASS Codes 180 or 181.that continue in an unlicensed home beyond six months 
will no longer be eligible for the new Northstar Care state share. 

http://www.dhs.state.mn.us/main/idcplg?IdcService=GET_DYNAMIC_CONVERSION&RevisionSelectionMethod=LatestReleased&dDocName=id_000404
http://www.dhs.state.mn.us/main/idcplg?IdcService=GET_DYNAMIC_CONVERSION&RevisionSelectionMethod=LatestReleased&dDocName=id_000447
http://www.dhs.state.mn.us/main/idcplg?IdcService=GET_DYNAMIC_CONVERSION&RevisionSelectionMethod=LatestReleased&dDocName=id_000441
http://www.dhs.state.mn.us/main/idcplg?IdcService=GET_DYNAMIC_CONVERSION&RevisionSelectionMethod=LatestReleased&dDocName=dhs16_144334
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How to Pay for Bed Holds 
There have been questions coming to the SSIS Helpdesk and the Northstar policy email regarding how to set up payments for 
“bed holds”.  Please review the charts on pages 4-5 for answers to these questions. 
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Client Specific – Temporary Absence 

SCENARIO PAY TO PAYMENT ENTRY REPORTING IMPACT 

1 Child is TEMPORARILY absent  
from the child family foster home 
placement due to hospitalization, 
home visit, camp, runaway status 
or other situation. Foster care 
maintenance is NOT being paid  
to a different caregiver or facility. 

Current   
family  
foster care 
provider 

Continue to pay using BRASS 
code 180 or 181 for 14 days of 
the temporary absence. 

Hint: If the child does not  
return within 14 days,  
Scenario 2 applies. 

Included in the Title IV-E  
Abstract Report and Northstar 
Care Fiscal Reconciliation*. 

2 Child is no longer TEMPORARILY 
absent (Scenario 1) from the child 
foster home placement because it 
has been longer than 14 days, and 
foster care maintenance is NOT 
being paid to a different caregiver 
or facility. 

Current   
family  
foster care 
provider 

Continue to pay using BRASS 
Code 180 or 181. 

Select Special cost code  
“96 – additional foster care  
(non-reimbursable)” 

Not eligible for Title IV-E or 
Northstar reimbursement and is 
not included in Northstar Care 
Fiscal Reconciliation*. 

3 Child is TEMPORARILY absent from 
the child foster home placement 
and foster care maintenance is  
NOT being paid to the current  
child foster home provider. 

Current  
family  
foster care 
provider 

No Payment N/A 

Second  
caregiver  
or facility 

Select the appropriate BRASS 
Code for the service. 

Depending on the appropriate 
BRASS code selected, the  
payment may or may not be  
included in the Title IV-E Abstract 
Report or Northstar Care Fiscal 
Reconciliation*. 
 

Client Specific – Respite Care 

SCENARIO PAY TO PAYMENT ENTRY REPORTING IMPACT 

Child is TEMPORARILY absent from 
the child foster home placement, 
and receiving Respite services. 

Foster care maintenance is being 
paid to current provider.  

Current   
family foster 
care provider 

Continue to pay using BRASS 
Code 180 or 181. 

Included in the Title IV-E Abstract 
Report and Northstar Care Fiscal 
Reconciliation*. 

4  

Respite  
provider 

Pay using BRASS Code 189. Not eligible for Title IV-E or 
Northstar reimbursement and is 
not included in Northstar Care 
Fiscal Reconciliation*. 

http://www.dhs.state.mn.us/main/idcplg?IdcService=GET_DYNAMIC_CONVERSION&RevisionSelectionMethod=LatestReleased&dDocName=id_000404
http://www.dhs.state.mn.us/main/idcplg?IdcService=GET_DYNAMIC_CONVERSION&RevisionSelectionMethod=LatestReleased&dDocName=id_000447
http://www.dhs.state.mn.us/main/idcplg?IdcService=GET_DYNAMIC_CONVERSION&RevisionSelectionMethod=LatestReleased&dDocName=id_000441
http://www.dhs.state.mn.us/main/idcplg?IdcService=GET_DYNAMIC_CONVERSION&RevisionSelectionMethod=LatestReleased&dDocName=dhs16_144334
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How to Pay for Bed Holds continued 
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Client Specific – Pre-Placement Location 

SCENARIO PAY TO PAYMENT ENTRY REPORTING IMPACT 

5 Child is in a child foster home  
placement, but is in a pre-
placement location with a  
different provider and foster care 
maintenance is NOT being paid  
to a different caregiver or facility. 

Current   
family  
foster care 
provider 

Continue to pay using BRASS 
code 180 or 181 for 14 days of 
the temporary absence. 

Hint: If the child does not re-
turn within 14 days, Scenario  
2 applies. 

Included in the Title IV-E Abstract 
Report and Northstar Care Fiscal 
Reconciliation*. 

  

6  Child is in a child foster home  
placement, but is in a pre-
placement location with a  
different provider and foster care 
maintenance is also being paid to 
the pre-placement provider.   

Current  
provider 

Continue to pay using  
appropriate BRASS code  
for current provider. 

Included in the Title IV-E Abstract 
Report and Northstar Care Fiscal 
Reconciliation*. 

Pre-
placement 
provider 

Pay using BRASS Code 180  
or 181 for Pre-Placement  
location. 

Select Special cost code  
“96 – additional foster care 
(non-reimbursable)”. 

Not eligible for Title IV-E or 
Northstar reimbursement and is 
not included in Northstar Care 
Fiscal Reconciliation*. 

Non-Client Specific – Available for Emergency/Law Enforcement Placements 

SCENARIO PAY TO PAYMENT ENTRY REPORTING IMPACT 

7  A per diem, monthly payment,  
or other service fee is being paid  
to a family foster home. This is not 
for a specific child, but rather for 
the purpose of having the home 
available to accept emergency 
placements from law enforcement.  

Option 1 (preferred):  

Pay using BRASS Code 196  
Licensing and Resource  
Development.  

Non-client specific Payments  
are not eligible for Title IV-E or 
Northstar reimbursement and 
are not included in Northstar 
Care Fiscal Reconciliation*.   

A family  
foster home   

Option 2 (acceptable):  

Pay by not selecting a client 
and use BRASS Code 180 or 
181.  

Select Special cost code “96 – 
additional foster care (non-
reimbursable)”.  

Hint: By selecting a Special cost 
code units are not reported to 
SEAGR.  

* Northstar Care Fiscal Reconciliation: Expenditures included in the Northstar Fiscal Reconciliation process will earn 
Northstar Care state share reimbursement. 

http://www.dhs.state.mn.us/main/idcplg?IdcService=GET_DYNAMIC_CONVERSION&RevisionSelectionMethod=LatestReleased&dDocName=id_000404
http://www.dhs.state.mn.us/main/idcplg?IdcService=GET_DYNAMIC_CONVERSION&RevisionSelectionMethod=LatestReleased&dDocName=id_000447
http://www.dhs.state.mn.us/main/idcplg?IdcService=GET_DYNAMIC_CONVERSION&RevisionSelectionMethod=LatestReleased&dDocName=id_000441
http://www.dhs.state.mn.us/main/idcplg?IdcService=GET_DYNAMIC_CONVERSION&RevisionSelectionMethod=LatestReleased&dDocName=dhs16_144334


 

 

V14.4  
Fiscal Release Training  

 

Recording (12/22/2014)  

is available on iLinc 
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  SSIS Worker 14.4 Documentation       
  and New iLinc Sessions  

 

 

 

 

 

 

 

 

 

 

 

 

 

SSIS Worker Documentation for 14.4 Release are available 
from the SSIS Home Page under Training > Release& Pilot. 
This includes job aids and tutorials for the Minnesota Assess-
ment of Parenting Children and Youth  (MAPCY) and 
Northstar Kinship Assistance. 

Two iLincs are available to watch related to Northstar Care or 
Children changes in SSIS Worker in 14.4: V14.4Northstar Kin-
ship Recording and SSIS V14.4 MAPCY Webinar SSIS Record-
ing. 

Additionally, four Northstar recorded iLincs are available for 
view: Overview, Supervisor, Licensing, and Permanency. 
Northstar Training Power Point handouts are available from 
the MN Child Welfare Training System page. 

To access an iLinc recorded training: 

1. Click on iLinc 

2. Click on the Public Sessions tab. 

3. Click on the Join tab. 

4. Find the training name. 

5. Click on the Open button for that session: it will open in 
a new window and the training recording will play. 

 

 

Review County Preference Settings 
NOTE: Review Security Functions roles  

edited from the original published on 12.15.14 

 

2015 Yearly Settings  

If you haven’t already set up your 2015 SSIS Admin settings, 
now is the time to do so. Workers cannot create new Service 
Arrangements, make Payments, or copy the 2014 COA Maxi-
mums without entering Yearly Settings for 2015.  

The following link can provide you with direction for those 
settings, see 2015 Yearly Settings and Admin Review. 

County Preferences to review in Admin:  

 Program area retention period 

 Add new COA Codes 

 Service Agreement language in Admin. If needed, cre-
ate new default language if different from the SSIS de-
fault. 

 Update Title IV-E Maintenance Agreements 

 
Review Security Functions  

Review security roles and functions for needed additions, 
deletions or changes, to ensure system integrity. Correct 
roles for users that may be outdated. Use SSIS Admin General 
Reports to review your user setup in SSIS Admin.  

The following link provides more information, see General 
Reports in SSIS Admin.  

Remove roles for staff that have left the agency. Change the 
role to <NONE> for Staff no longer employed. Changing the 
Role field option to <NONE> makes the user inactive and re-
moves their name from the drop-down lists and they will no 
longer display when “Active workers only” is checked in vari-
ous searches.  

Questions to ask: Do current roles need updating? Can a 
worker do the job they need to do in SSIS? Are departments 
correct and are units correctly associated? Are supervisors 
correctly associated to the units? Do external placement case 
managers need updating? 

  

Additional settings to check in SSIS Administration:  

In SSIS Admin, use Lists in the menu to update county ac-
counting system batch owners using Lists. You can also access 
and make changes to departments using Department Search, 
location using Location Search, roles using Role Search, units 
using Unit Search and users by accessing User Search.  

 

County Specific Accrual Codes 

 Time reporting period 

 Special Studies 

 Local Agency created  

 End date needed?  

 Change study level?  

 Staff, workgroups and clients associated  
correctly?  

 

 

 

 

 

http://www.dhs.state.mn.us/main/idcplg?IdcService=GET_DYNAMIC_CONVERSION&RevisionSelectionMethod=LatestReleased&dDocName=id_000404
http://www.dhs.state.mn.us/main/idcplg?IdcService=GET_DYNAMIC_CONVERSION&RevisionSelectionMethod=LatestReleased&dDocName=id_000447
http://www.dhs.state.mn.us/main/idcplg?IdcService=GET_DYNAMIC_CONVERSION&RevisionSelectionMethod=LatestReleased&dDocName=id_000441
http://www.dhs.state.mn.us/main/idcplg?IdcService=GET_DYNAMIC_CONVERSION&RevisionSelectionMethod=LatestReleased&dDocName=dhs16_144334
http://www.dhs.state.mn.us/main/idcplg?IdcService=GET_DYNAMIC_CONVERSION&RevisionSelectionMethod=LatestReleased&dDocName=id_000404
http://www.dhs.state.mn.us/main/idcplg?IdcService=GET_DYNAMIC_CONVERSION&RevisionSelectionMethod=LatestReleased&dDocName=id_000476
https://minnesota.ilinc.com/
http://www.dhs.state.mn.us/main/idcplg?IdcService=GET_DYNAMIC_CONVERSION&RevisionSelectionMethod=LatestReleased&dDocName=id_000158
http://www.dhs.state.mn.us/main/groups/county_access/documents/pub/dhs16_191351.pdf
http://www.dhs.state.mn.us/main/groups/agencywide/documents/pub/dhs16_163428.pdf
http://www.dhs.state.mn.us/main/groups/agencywide/documents/pub/dhs16_163428.pdf
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Tips and Tricks for Rich Text Format (RTF) Headers 

The new RTF (Rich Text Format) Documents have been introduced to SSIS.  As with the previous documents, some 
of the new documents will require Local Agency headers.  Due to the new type of formatting, previously created 
headers in the SSIS Document Template Editor cannot be used for this.  Instead, agencies will need to create new 
RTF Document Template Headers.  Here are some helpful tips for creating these new headers. 

TOOLS MENU  
RTF Document Template Headers are accessed via the “Tools” menu. 

 

ACTION MENU 
Select the “Action” menu  
to create a new Header.  Enter a title in the “Template Name” field. 

 

EDITOR   

Select the blue E to open the editor. 

 

PAGE LAYOUT   

Click on the “Page Layout” tab to access the “Margins” setup. 

 
MARGINS 
Select “Custom Margins”,  
and change the “Left”  
and “Right” margins  
to one inch.   
 
Click “OK” when finished. 
 
 
 
 
 
 
 
VIEW 
Navigate  
to the “View”  
tab to access  
“Document Views”.   
 
Change the view to “Print Layout”.   
This will help gauge how well the Header fits within the page width. 

 

INLINE PICTURE (Inserting a logo) 

Navigate to the “Insert” tab to access “Illustrations”.   
Use the “Inline Picture” option to insert a logo.   
OR 
Insert a table into the Header first; paste the  
copied image into one of the table cells.   

Things to Note 

 A RTF Document Template Header 
cannot be deleted once it is created 
and saved. 

 A RTF Document Template Header 
can be edited at any time.  Use the 
“Re-Merge Document” option to  
update an edited Header on an  
existing RTF Document. 

 Use the “Print Layout” document 
view in RTF Documents in order to 
see how a Header looks on a specific 
document. 

http://www.dhs.state.mn.us/main/idcplg?IdcService=GET_DYNAMIC_CONVERSION&RevisionSelectionMethod=LatestReleased&dDocName=id_000404
http://www.dhs.state.mn.us/main/idcplg?IdcService=GET_DYNAMIC_CONVERSION&RevisionSelectionMethod=LatestReleased&dDocName=id_000447
http://www.dhs.state.mn.us/main/idcplg?IdcService=GET_DYNAMIC_CONVERSION&RevisionSelectionMethod=LatestReleased&dDocName=id_000441
http://www.dhs.state.mn.us/main/idcplg?IdcService=GET_DYNAMIC_CONVERSION&RevisionSelectionMethod=LatestReleased&dDocName=dhs16_144334
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NOW HIRING: SSIS Fiscal Sr. Business Analyst 
 Information Technology Specialist 3, $24.72-$40.63 hourly,  $51,615 - $84,835 annually 
 

As a Business Analyst, you will perform business analysis functions using a set of tasks and techniques to successfully act as a 

liaison among stakeholders in order to understand the structure, policies and operations of an organization and to be able to 

recommend solutions that enable projects to be successful and goals to be met. In particular, this includes participating in re-

quirements gathering sessions to analyze, define and document business processes, software requirements, data management 

systems, interface specifications and development of specifications for technology initiatives. You will also work as a liaison 

between IT and business representatives, analyzing business activities and presenting the findings for analysis of solutions to 

purchase, implement, or develop. This includes working with development team members by collaborating on the develop-

ment, testing, deployment and adoption of solutions. In addition, you will be responsible for communicating and consulting 

with system user populations concerning system changes and implementation planning for changes and releases.  

This particular position works closely with county and tribal social services accounting staff as well as policy staff in financial 

operations, child welfare, aging and adult services, mental health and disability services to implement policy related to social 

services in the Social Services Information System (SSIS) application. 

 

Minimum Qualifications: 

This position requires a minimum of three (3) years of experience in performing IT business analysis functions. 

 

Preferred Qualifications: 

 Demonstrated leadership, mentoring skills, analysis, and problem solving skills  

 Ability to communicate clearly in writing and orally, present complex information to users in a comprehensive style, 

and translate technical and system information for non-technical stakeholders 

 Proven ability to collaborate and work effectively as part of a team 

 Ability to organize and prioritize multiple deadlines and work independently; to define problems as they arise and to 

recommend alternative solutions 

 Demonstrated problem-solving skills in problem definition, information gathering and research, alternatives analysis, 

applying creative solutions to unique and/or immediate problems, and appropriate resolution implementation 

 Local agency social service accounting experience  or experience working in social services with the SSIS Fiscal appli-

cation or in a related DHS policy area (child welfare, aging and adult services, mental health, disability services, finan-

cial operations).  

  

  

  

  

    

To View the Posting and Apply 

Visit State Jobs—Info Tech Spec 3, Business Analyst  

Please forward the posting to candidates you or your 

staff may know of and encourage them to apply. 
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For Position Information 

Contact Kate Stolpman  

at 651-431-4743  

or kate.stolpman@state.mn.us  

https://statejobs.doer.state.mn.us/JobPosting/View?_posting=14MNIT000409
http://www.dhs.state.mn.us/main/idcplg?IdcService=GET_DYNAMIC_CONVERSION&RevisionSelectionMethod=LatestReleased&dDocName=id_000404
http://www.dhs.state.mn.us/main/idcplg?IdcService=GET_DYNAMIC_CONVERSION&RevisionSelectionMethod=LatestReleased&dDocName=id_000447
http://www.dhs.state.mn.us/main/idcplg?IdcService=GET_DYNAMIC_CONVERSION&RevisionSelectionMethod=LatestReleased&dDocName=id_000441
http://www.dhs.state.mn.us/main/idcplg?IdcService=GET_DYNAMIC_CONVERSION&RevisionSelectionMethod=LatestReleased&dDocName=dhs16_144334
mailto:kate.stolpman@state.mn.us?subject=SSIS%20Update%20Inquiry%20RE:%20SSIS%20Fiscal%20Sr.%20Business%20Analyst



